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Microsoft Excel - Selection Techniques 
 

The selection techniques in Microsoft Excel allow you to select or highlight the cell(s) quickly so that you 

can perform the tasks such as deleting, copying, etc. 

To select a cell 

• Click on the cell you wish to select.   

To select a range of cells by dragging the mouse 

• Click on the first cell in the range.  

• Hold down the left-hand mouse button 

and drag over the cells you wish to 

include in the selection.  

 

To select a range of cells (making up a rectangular block)  

• Click on the first cell of the rectangular block that you wish  

to select (i.e. the left top-left hand corner)  

• Move down to the cell that marks the bottom-

right corner of the rectangular block.  

• Depress the Shift key (and keep it depress).  

• Click once on the last cell of the required 

block and release the Shift key. 

 

To select a non-contiguous range 

• Select the first cell or range.  

• While holding down the Ctrl key, select the next 

range of cells. 

To select a row 

• Click on the row heading number.  

 

To select a column 

• Click on the column heading letter.   

To select an entire worksheet 

• Press Ctrl+A 

  

1st Click 
Depress your 
Shift key. Move 
your mouse to 
the desired 
location, 2nd 
click. 
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Keyboard Shortcuts 
Popular Keyboard Shortcuts for Excel 

Basic File Operations  

Keyboard Shortcut Action 

Ctrl + N Open new workbook 

Ctrl + O Open existing workbook 

Ctrl + W Close active workbook 

Ctrl + S Save active workbook 

F12 Save As … different name, location, file type 

Alt + F4 Close Excel 

F1 Open help menu 

  

Undo, Restore Repeat  

Keyboard Shortcut Action 

Ctrl + Z Undo last action 

Ctrl + Y Restore undo action 

F4 Repeat last action 

  

Insert, Delete, Copy  

Keyboard Shortcut Action 

Ctrl + C Copy selection to clipboard 

Ctrl + X Cut selection to clipboard 

Ctrl + V Paste last selection that was cut or copied to clipboard 

Delete Clear contents of current selection (leave formatting in place) 

Ctrl + - (minus) Open Delete Cells dialog box 

Ctrl + + (plus) Open Insert Cells dialog box 

Ctrl + ' (apostrophe) Copy contents of cell above into active cell; formulas are an exact copy 

Ctrl + R Copy contents of cell to the left into active cell; formulas are an exact 
copy 

Shift + F10 Open shortcut - contextual menu; use up & down arrow key + enter to 
make selection 

  

Edit Data  

Keyboard Shortcut Action 

F2 Begin editing active cell; insertion point is at end of cell contents 

Home While in edit mode, move insertion point to beginning of cell contents 

End While in edit mode, move insertion point to end of cell contents 

Ctrl + → While in edit mode, move insertion point one word to the right 

Ctrl +  While in edit mode, move insertion point one word to the left 

Backspace While in edit mode, delete character to left of insertion point 

Delete While in edit mode, delete character to right of insertion point 

Ctrl + Delete While in edit mode, delete all characters from insertion point to end of 
cell contents 

' (apostrophe) As 1st character in cell, format entry as "text" 

F7 Begin Spell Check 

 

Show / Hide Columns and Rows  

Keyboard Shortcut  Action  

Ctrl + 0 (zero)  Hide current column  

Ctrl + 9  Hide current row  

Ctrl + Shift + 9  Unhide current row  

Ctrl + Shift + (  Unhide rows within selection  

Ctrl + Shift + )  Unhide columns within selection  
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Select Contiguous Cells  

Keyboard Shortcut  Action  

Shift + Directional Arrow  Select the cell(s) in that direction (left, right, up, or down)  

Ctrl + Shift + Directional Arrow  Select to the last occupied cell in that direction (left, right, 
up, or down)  

Ctrl + Shift + End  Select from active cell to last occupied cell that is down and 
to the right  

Ctrl + Shift + Home  Select from active cell to first occupied cell that is up and to 
the left  

Shift + Backspace  Collapse cell selection to just active cell  

Ctrl + A  Select all of the occupied cells in current range; press again 
to select all cells in worksheet  

Ctrl + Space Bar  Select all cells in current column  

Shift + Space Bar  Select all cells in current row  

Ctrl + Shift + + (plus sign)  Insert new row - select row first  

Ctrl + - (hyphen)  Delete selected row - select row first  

Navigate Within a Worksheet  

Tab or → Move one cell to right  

Shift + Tab or  Move one cell to left  

  Move one cell up  

 Move once cell down  

Ctrl + → OR Dbl Click on right of 
cell 

Move to last occupied cell in row of data block  

Ctrl +  OR Dbl click on left of cell Move to first occupied cell in row of data block  

Ctrl +  OR Dbl click on bottom of 
cell 

Move to last occupied cell in column of data block  

Ctrl +  OR Dbl click on Top of cell Move to first occupied cell in column of data block  

Ctrl + End  Move to last (bottom) occupied cell of data block  

Ctrl + Home  Move to cell A1  

Navigate Between Workbooks  

Ctrl + Page Down  Move to and activate next worksheet in workbook  

Ctrl + Page Up  Move to and activate previous worksheet in workbook  

Shift + F11  Insert new worksheet to left of active worksheet  

Enter Data  

Keyboard Shortcut Action 

Ctrl + ; (semi-colon) Enter current date 

Ctrl + Shift + : (colon) Enter current time 

Enter Accept entry and move active cell down one row 

Ctrl + Enter Accept entry and keep active cell in place 

Shift + Enter Accept entry and move active cell up one row 

Tab Accept entry and move active cell one column to right 

Shift + Tab Accept entry and move active cell one column to left 

Alt + Enter Create line break in the same cell; this is a "text wrap" 

Esc Cancel cell entry 

Print Worksheet  

Keyboard Shortcut Action 

Ctrl + P Open Print dialog box 

Ctrl + F2 Open Print Preview mode 

Work With Charts  

Keyboard Shortcut Action 

F11 Create column chart of selected data on new worksheet 

Alt + F1 Create column chart of selected data on current worksheet 



 P a g e  | 5 

 

One Click to Select All 
Click the corner button (above 1 row and left of A column) to select the entire worksheet. This would 

allow you to copy and paste the entire contents. It will also allow you to auto-fit columns!  

Add more than one Row or Column 
If you want to insert more than row, say 5, simply click and drag that number of row (or column) 

headers. Right mouse click and select Insert. 

Move around in a list 
Ctrl + Down Arrow   OR  Double click the bottom border of the cell 

Ctrl + Up Arrow  OR  Double click the top border of the cell 

Ctrl + Right Arrow  OR  Double click the right border of the cell 

Ctrl + Left Arrow  OR  Double click the left border of the cell 

Autofill 
Whether you just want to copy the same value down or need to get a series of numbers or text values, fill 

handle in Excel is the feature to help. Fill handle is a small square that appears in the bottom-right 

corner when you select a cell or range. Drag the autofill handle any direction (right, left, up, or down).  

In the example below, we are using the autofill handle to fill in the Months of the year. You can copy 

formulas, copy data and formatting, fill a series of numbers, dates, months, or days.   

         

NOTE: Double Click the autofill handle to fill to the bottom (this only works filling down).  

Use the autofill options to control the autofill contents.  For example, if you enter in a date, you can use 

the autofill handle and Excel will fill in dates sequentially. Use Autofill options to change the dates to 

only fill Weekdays. You can also use options to fill in numbers sequentially.  
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Using Formulas in Excel 
Excel is a great tool to record, store, and sort information, especially numerical facts and figures. But the 

real versatility of this program can be found by using formulas to calculate data. Excel can do a lot of 

number crunching, even on older computers. 

In order to make the most of formulas, you need to understand the bits and pieces that are used to 

create them. In this lesson we will cover all the key concepts to get you started with formulas. 

Understanding Relative and Absolute Cell References 
You already know that worksheets are composed of rows (horizontal, referenced with numbers) and 

columns (vertical, referenced with letters). The intersection of each row with a column forms a cell, and 

each cell is given a name in the format ColumnRow.  

Consider the following worksheet: 

 

The current cell, C2, contains a formula which multiplies A2 B2. You can see this formula in the formula 

bar. Now, if we click and drag the small square in the bottom right-hand corner of the active cell down 

one cell (C3), watch what happens: 

 

 

C3 now contains 46.62 because the cell references, which are now visible in the formula bar, have 

changed. When the AutoFill operation was performed, the cell references were modified relative to the 

location of the formula. It now multiplies A3 * B3; in order words 2.59 X 18 = 46.62 
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The same thing will happen if we copy and paste C2 somewhere else.  Copy and pasted into Cell C5 the 

formula moves two rows down and now multiplies A5 * B5 

 

 

To avoid this, use absolute cell references. These references use dollar signs ($) to make sure a formula 

always references the same location, no matter where it is moved. You can assign absolute cell 

references in three ways: 

▪ $Column$Row: Both the row and column designation won’t change ($A$1) 

▪ $ColumnRow: The column designation won’t change, but the row can ($A1) 

▪ Column$Row: The row designation won’t change, but the column can (A$1) 

▪  

If we add absolute cell references to our sample formula, the formula can be added anywhere and the 

value won’t change.  We can now copy this formula down using the autofill handle and the formula will 

multiply the total in each row (relative reference) by the tax in cell G1 (absolute reference).  

 

 

You aren’t restricted to using only relative or only absolute cell references. Simply add the dollar signs 

wherever you need an absolute reference.  

NOTE: Use your F4 function key to add absolute references while the cell is selected.  
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Order of Operation Arithmetic Operator Excel Symbol 

Please  Parentheses  () 

Excuse Exponents ^ 

My Multiplication  * 

Dear  Division / 

Aunt Addition + 

Sally Subtraction  - 

Example 1: 

 
 

 

 

 

 

Example 2 

 

 

 

 

Your answer here is 5 because order of 

operation multiplies 1 X 2 (B1*C1) which 

equals 2. It then adds 2 + 3 (2+A1) which 

equals 5 

Your answer here is 8 because order of 

operation first does what is inside of 

parentheses and adds 3+1 (A1+B1) which 

equals 4. It then multiples 4X2 (4*C1) which 

equals 8. 
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Arithmetic operators 

To perform basic mathematical operations such as addition, subtraction, or multiplication; combine 

numbers; and produce numeric results, use the following arithmetic operators.  

Arithmetic operator Meaning Example 

+ (plus sign) Addition 3+3 

– (minus sign) Subtraction/Negation 3–1–1 

* (asterisk) Multiplication 3*3 

/ (forward slash) Division 3/3 

% (percent sign) Percent 20% 

^ (caret) Exponentiation 3^2 (the same as 3*3) 

 

Comparison operators 

You can compare two values with the following operators. When two values are compared by using these 

operators, the result is a logical value, either TRUE or FALSE. 

 Comparison operator Meaning Example 

= (equal sign) Equal to A1=B1 

(greater than sign) Greater than A1>B1 

< (less than sign) Less than A1<B1 

>= (greater than or equal 

to sign) 

Greater than or 

equal to 

A1>=B1 

<= (less than or equal to 

sign) 

Less than or equal 

to 

A1<=B1 

<> (not equal to sign) Not equal to A1<>B1 
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Show Formulas 
The Show Formulas command will show all of the formulas in the worksheet rather than their computed 

value. This is a toggle command that also expands the column widths so the formulas are easier to read: 

 

This mode is very useful when you are creating formulas for a large sheet. You can ensure that the 

formulas are correct before adding or computing data. Viewing formulas also makes it easier for others to 

view your work and understand how values are calculated instead of clicking cells one at a time and 

looking at the formula bar. 

Click this command again to show the calculated values. The columns will also return to their normal 

widths. 

Error Checking 
This function works like the spell checking command in a word processing program. Excel does actively 

check for some errors as you are entering formulas, but there are some issues that Excel’s automatic 

checking cannot account for.  

For example, here we have mistyped a cell reference in the formula in cell D2. This affects the formula 

in this cell as well as the dependent cell in the Profit column: 
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Click the Error Checking command to make Excel scour your worksheet for any errors. If any are found, 

they will be listed one at a time in the Error Checking dialog box: 

 

This this case, D2 contains a naming error: the cell reference “B” is incomplete. Use the buttons on the 

right to: 

▪ Update the formula 

▪ Get help on the error 

▪ Ignore the error 

▪ Edit in the formula bar 

Click the Options button to open the Options dialog to the Formulas category. Here you can enable or 

disable the background checking option, choose the color used to highlight errors, and reset errors that 

were previously marked to be ignored: 

 

 

Evaluate Formula 
As we have seen by examining the other commands in this section, there are a number of commands you 

can use to easily and accurately track what a formula is doing. The Evaluate Formula command takes this 

concept one step further by showing you every single calculation that was used to reach a particular 

value. This command is extremely useful for making sure a complex formula is doing exactly what you 

intend it to do, or for finding that one small piece that is causing your calculation to fail along the way. 
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Here, we have selected a value in the Profit column of our sales worksheet and will step through the 

formula: 

 

 

The Evaluate Formula dialog box will appear and show the formula that will be evaluated: 

 

Click Evaluate to step into the first part of the formula. It turns the first reference into the number.   
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Now, the next value is highlighted and the option to Step In is available again. Click Evaluate to continue 

checking and evaluating the formula: 

 

Eventually, the checker will step through all the calculations one at a time before showing you the final 

step: 

 

        

Clicking Evaluate once more will perform the final calculation and show the result. Clicking Evaluate a 

final time will start the process over from the beginning. 
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Watch Window 
Imagine that you are compiling a very large number of survey results. As you add more and more data to 

the worksheets, it can be challenging to keep an eye on certain key values. The watch window is 

designed to display the value of certain cells as other information is changed within the worksheet. The 

watch window is a floating window that will remain open no matter what you are doing with Excel. 

Consider the completed sales worksheet that we have been using throughout this lesson: 

 

If you want to keep track of a certain value in the Profit column, a watch window is perfect. 

To use this tool, simply click the cell you want to watch and then click Watch Window. A new window 

will appear and show you all the vital statistics regarding this value: 

 

The Watch Window is very simple to use: 

▪ To move the active cell to a value in the Watch Window, double-click a value. 
▪ To add more values to this window, click Add Watch and specify the cell.  
▪ To remove values, select one from the Watch Window and click Delete Watch. 
▪ When you are finished with the Watch Window, click the close button. 
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Relative, Absolute & Mixed References 
You can use three types of cell references in Excel formulas: relative, absolute, and mixed. Using the 

correct type of cell reference in formulas ensures that they work as expected when you copy them to 

another location in the worksheet. 

When copying formulas in Excel, relative addressing is usually what you want. That's why it's the default 

behavior. Sometimes you don't want relative addressing but rather absolute addressing: making a cell 

reference fixed to an absolute cell address so that it doesn't change when the formula is copied. 

In an absolute cell reference, a dollar sign ($) precedes both the 

column letter and the row number. Use your F4 Function key to make 

a cell an absolute reference. You can also have a mixed reference in 

which the column is absolute and the row is relative or vice versa. To 

create a mixed reference, you use the dollar sign in front of just the 

column letter or row number. Here are some examples: 

Reference Type Formula What Happens After Copying the Formula 
Relative =A1 Both the column letter A and the row number 1 can change. 
Absolute =$A$1 The column letter A and the row number 1 do not change. 
Mixed =$A1 The column letter A does not change. The row number 1 can change. 
Mixed =A$1 The column letter A can change. The row number 1 does not change. 

AutoSum Tricks  
Excel’s AutoSum Button enables you to quickly add a group of numbers together. It also 

lets you find the average of a group of numbers, count them, find the highest and 

lowest number. The AutoSum button is conveniently located on the Home Tab in the 

Editing group AND on the Formulas tab in the Function Library group.  

Keyboard shortcut:   Alt + = 

Use your ctrl to select specific cells or many ranges of cells. 

 

Select a blank column / row and then use AutoSum to fill in the blank columns and rows all at once.  
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AutoSum 

1) Click the cell you want your answer in.  

2) From the Home Tab, within the Editing group, click the AutoSum button.  

 

3) Excel will automatically select a group of cells it “thinks” you 

would like to add up. If it is not the correct group of numbers, 

simply click and drag on the group of cells you wish to add up.  

4) Press the Enter key or click the checkmark on the Formula Bar to 

receive the answer.  

 

Find the Average of a group of numbers using the AutoSum dropdown 

1) Click the cell you want your answer in. 

2) From the Home Tab, within the Editing group, click the dropdown arrow on the AutoSum button. 

Select Average. 

 

3) Excel will automatically select a group of cells it “thinks” you would 

like to find the average of. If it is not correct, click and drag on the 

group of numbers you wish to find the average of. 

4) Press Enter or click the checkmark on the Formula bar to receive 

the answer.  
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Quick Analysis 
Quick Analysis provides an amazing way for you to preview your data with different Excel tools including, 

conditional formatting, tables, charts and PivotTables. Select your range of data including the column 

headings. Click the Quick Analysis tool that appears in the lower right corner of your selection.  

 

Doing this open the pallets of Quick Analysis Options with the initial Formatting tab selected and its 

various conditional formatting options displayed.  There are five tools displayed: Format, Charts, Totals, 

Tables and Sparklines.  

 

Hovering over any of the selections, will update your data with a preview of what it will look like if you 

apply the formatting.  

 

 Format: you’ll find a preview of the most useful options of conditional formatting. 
 Charts: This shows you recommended charts for your selected data.  
 Totals: Excel can show different basic calculations such as Sum, Count, or Average. This 

tab is similar to the AutoSum button. 
 Tables: This will turn your data into a table and also contains Recommended PivotTables 
 Sparklines: These are mini-charts in a cell that can show you the trend of data.  
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FlashFill 
This tool can detect data entry patterns and extract and enter data that follows a recognizable pattern. 

It solves common problems such having a person’s first and last name in the same column or vice versa. 

To use, click cell adjacent to the data. Type the first example of how you would your data to look. Press 

Enter.  

 

Start typing the next example. Flash fill will appear while you are typing the second example so keep a 

close eye on your screen.  Press enter to FlashFill your data.  

          

Charting Tools 
Excel 2013 has moved the Layout Tab into a set of icons that appear outside the top right edge of a chart 

when it is selected. Click any of these buttons, Chart Elements, Chart Styles or Chart Filters (NEW!!), to 

reveal additional chart layout options.  

Chart elements is used to add or remove elements such as titles and legends. 
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Chart Styles allows you to change the style and colors of your chart.  

 

Chart filters allows you filter out data. 

 

Saving a Chart as a Template 
Once you get your chart looking just the way you like it, you can save the chart type, colors, and 

formatting as a template that can be reused to make on future charts. 

 

To save this chart as a template, right mouse click the chart (either in the plot area or chart area) and 

choose Save as Template. This will display a Save Chart Template dialogue box; it’s virtually identical to 

the regular Save dialog. Just enter an appropriate name for your chart template and then click the Save 

button. By default, the templates will be saved in an Excel chart folder. Then, you can apply the 

template right away by selecting it from the Templates folder.  

 

If you select Templates in the pane on the left of the box, you will see the chart template that you saved 

displayed on the right side. Just click the template icon to apply the template to the selected data. 
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Create Charts with Keyboard Shortcuts 
You can quickly add charts to your workbook using two different keyboard shortcuts.  

1. To add a chart into the worksheet that is currently active, select the data you wish to chart and 

press  

Alt + F1.  

 

2. To a chart into a new worksheet in your workbook, select the data you wish to chart and press the 

F11 key. This chart your data and place in a worksheet of its own.  

 

Change the Default Chart Type 

You can change the default chart type that is inserted into your worksheets. 

1. Open the Change Chart Type dialog box by inserting a chart. Then, from the Chart Tools Ribbon 

Option, on the Design Tab, in the Type Group, click Change Chart Type. 
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2. In the Change Chart Type dialog box, right mouse click the chart you wish to set as your default. 

Select Set as Default Chart. 

 
 

3. Click OK.  

 

Paste Link 
You can paste links between cells within Excel, so that the value of a cell within a workbook will simply 

be the value of another selected cell. 

1. Copy the cell 

2. When you paste, select Paste Link.  
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Print Tricks 
• Scale to Fit 

 
Use Scale to fit if you need to make a worksheet fit when you need a few last rows or a 

columns on a single page. From the Page Layout tab, Scale to fit group, Select 1 page for 

both the Width and Height. Please note, you can select any number of pages needed to fit 

your needs.  

 

• Print Selection or Entire Workbook 

Highlight the group of cells you want to print. Select File >> Print. Under the Settings option, 

select Print Selection (to print what you have selected) or Print Entire Workbook to print each of 

the workbook tabs.  

 

• Print Page Titles 

We all have the large list that we want the heading to print on the top of each page. To 

do this select: 

Page Layout Tab >> Page Setup Group >> Print Titles 

 
Select the Row or rows you want to print at the top of each page.  

 
 

• Print Gridlines & Print Headings 

Page Layout Tab >> Sheet Options group. Check Print (Gridlines) and Print (Headings). 
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Now & Today Functions 
Manipulating Dates, Times & Text 

NOW 

In Excel, the NOW function returns the current system date and time. This function will refresh the 

date/time value whenever the worksheet recalculates. 

The syntax for the NOW function is: 

NOW() 

1. Click in the cell you wish the current date to appear.  

2. Type in the following: =NOW()  and press the enter key. 

 
 

 

TODAY 

In Excel, the TODAY function returns the current system date. This function will refresh the date 

whenever the worksheet recalculates. 

The syntax for the TODAY function is: 

TODAY() 

1. Click in the cell you wish the current date to appear.  

2. Type in the following: =TODAY()  and press the enter key. 

 
 

 

Date Keyboard Shortcuts 

• Current Date Ctrl + ; 

• Current Time Ctrl + Shift + ; 


